CTE Travel & Entertainment Reconciliation Form How To:

The new CTE Travel & Entertainment Reconciliation form (TERF) should be filed within 45 days of the conclusion of your travel, but it is recommended that you do so within 10 days of returning from your trip.

Your department/division may require more documentation in addition to FAST’s requirements. Please speak with your divisional/department leader to find out what is required before you submit your form. If you have more than 4 separate trips or entertainment events, you will need to fill out additional TERFs and attach them to the back of your original TERF.

Tip: It is recommended that you fill this form out electronically so that you can benefit from the automatic calculations, electronic signatures, and electronic submission that the form allows for.

Attachments: The following documents are attached to your TERF and can be accessed by selecting the embedded links in the PDF or selecting them from the Attachments column: TERF How To, ERA, ERA How To, TERF Worksheet. The TERF Worksheet is used to provide itemized documentation of expenses and attached for submission with the TERF.

Top of Form:

Adobe Reader: This form has been designed and optimized for use with Adobe Acrobat/Reader. This means for full functionality it should be opened and filled out with Adobe Acrobat or Adobe Reader. Note: the link will direct the user to UCSC’s ITS website for download and terms of service.

204 Submitted or On File: Check this box if traveler has recently completed the Payee Setup 204 form or already has an account in the BANNER Financial System. If you know that the traveler will be seeking reimbursement but does not have an account in Banner, ask them to complete a Payee Setup 204 form and submit it to FAR.

Personal Information:

Traveler’s Name: Enter sole traveler or group leader’s name as it was entered on the Payee Setup 204 form. For group leaders attach a list of co-traveler names or enter those names into the “Additional Notes” section.

Team Affiliation: Enter the team affiliation tied to the traveler or group. If there is no team affiliation leave blank.

Traveler’s Email: Provide preferred active email address.

Phone: Enter the best number to contract traveler (7 or 10 digit).
**Campus Mail Stop or Payment Address:** Provide address or campus mail stop where physical check payments should arrive. If traveler has a direct deposit BANNER account provide desired address where a physical check should be sent if one were to be created.

**Office Use:**

<table>
<thead>
<tr>
<th>Document #</th>
<th>Vendor #</th>
<th>Date Due</th>
</tr>
</thead>
</table>

**Document #, Vendor #, Date Due:** This section is for FAST use and should be left blank.

**Affiliation:**

<table>
<thead>
<tr>
<th>Affiliation</th>
<th>Select Campus</th>
</tr>
</thead>
<tbody>
<tr>
<td>U.S. Citizen</td>
<td>Foreign Visa Type</td>
</tr>
</tbody>
</table>

**Affiliation:** Select appropriate option between Visitor, UC Student, or UC Employee.

**Select Campus:** Select the campus the traveler is currently employed at or attending.

**U.S. Citizen:** Select citizenship status.

**Foreign Visa Type:** Select the choice that applies to the traveler.

**Form Prepared By:**

<table>
<thead>
<tr>
<th>Form Prepared By:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dept / Division:</td>
</tr>
<tr>
<td>E-mail:</td>
</tr>
<tr>
<td>Phone:</td>
</tr>
</tbody>
</table>

**Form Prepared By:** Enter name of person preparing form if not the traveler. If the traveler is preparing form, leave section blank.

**Dept/Division:** Department or division of form preparer.

**E-Mail:** Provide preferred active email address of preparer.

**Phone:** Enter preferred number to contact form preparer (7 or 10 digit).

**Payments Made to or on Behalf of Traveler:**
**Trip Number:** If a Travel Advance Request form was submitted pre-travel then enter the assigned trip number. Otherwise enter N/A or leave blank.

**TAR Payments:** If no expenses were paid on behalf of the traveler, or reimbursed early before the trip leave this area blank. If a TAR form exists for the trip, enter all expenses from the TAR Form’s Section 3 “payments made to or on behalf of traveler.”

**CTE Payments:** If no expenses were paid via U.S. Bank’s Corporate Travel & Entertainment Card, leave this area blank. If expenses were incurred, enter all appropriate categorized expenses directly shown on the CTE Card statement, or CTE Card transaction history.

**Cash Advance:** If a cash advance was issued with a TAR enter the dollar amount in this field.

**All Actual Expenses:**

<table>
<thead>
<tr>
<th>Travel Business Purpose</th>
<th>Select</th>
<th>Select</th>
<th>Select</th>
<th>Select</th>
<th>Total Expense</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Business Purpose (Detail)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Destination</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Personal Car Mileage:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Personal Car Mileage Reimbursement (before)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Airport</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rental Car</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other Transportation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parking/Fees</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conference Registration</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lodging</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Meals &amp; Incident (Not Include or # of Meals)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F&amp;B, Supplies (Beverages)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Entertainment</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$ 0.00</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>$ 0.00</td>
<td>$ 0.00</td>
<td>$ 0.00</td>
<td>$ 0.00</td>
<td>$ 0.00</td>
<td></td>
</tr>
</tbody>
</table>

**TERF Worksheet:** The link will open the attachments section of this PDF. Select the TERF Worksheet excel from that list to open and fill in all itemized expenses for each business purpose.

**Business Purpose:** Select the option that best fits the purpose of the trip, or select the “Manual Entry Here” option to write in your own business purpose.

**Date:** Enter the depart and return dates for the travel including transit to and from the destination.
**Business Purpose (Detail):** Add additional details to substantiate the business purpose of the trip, such as conference name, and ensure supporting documentation is attached, such as the conference agenda.

**Destination:** Provide city and state (domestic), or city and country (foreign).

**Personal Car Mileage & Reimbursement:** If a personal car was used enter the actual miles driven for entire trip from your workplace. The form will calculate the reimbursement amount due back at the current designated rate. For further information on Personal Car Mileage & Reimbursement see the Travel Guide.

**Airfare:** Enter the cost of all airline tickets, whether purchased through a TAR, CTE Card, or Out-of-Pocket.

**Rental Car:** Enter rental car cost here. Fuel costs for a rental vehicle should be added to the Other Transportation field.

**Other Transportation:** Costs for taxis, shuttle services, ride share, rental vehicle fuel costs, etc. should be entered in this row.

**Parking/Tolls:** Enter any meter, parking garage, or bridge toll costs in this row.

**Conference Registration:** Enter any conference/event registration costs here whether being reimbursed for Out-of-Pocket, charged to CTE Card, or previously paid directly by the University or through a TAR.

**Lodging:** Hotel Expenses are entered in this row. Only room charges and applicable taxes should be entered in this row. A non-cash hospitality gift expense up to $75 can be entered here if traveler stayed with relatives or friends instead of incurring hotel costs.

**Meals & Incidentals:** Enter actual expenses for meals in this row (up to daily (O)CONUS per diem rates).

**Misc. & Supplies:** Include other expenses not mentioned above in this row (baggage fees, housekeeping tips, etc.).

**Entertainment:** List any entertainment related expenses, and complete the attached Entertainment Reporting Addendum with proper authorization signatures and notation. Leave blank if no entertainment expenses were incurred.

**Totals:** If using Adobe Acrobat, all totals will self-calculate, giving the total amounts for each trip and for each expense type. If manually filling the form, ensure to total each row and column.

**Comments:** Enter pertinent information, description of expenses, or important statements about the travel for each expense type here.

**Traveler Certification and Totals:**

<table>
<thead>
<tr>
<th>Description</th>
<th>Amount</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Less payments made on behalf of traveler</td>
<td>$ 0.00</td>
<td>All actual Travel/Entertainment expenses paid for with the CTE card are not reimbursed, so reduce from the actual expense total.</td>
</tr>
<tr>
<td>Less Cash Advance</td>
<td>$ 0.00</td>
<td>Cash Advance is reduced from total expenses.</td>
</tr>
<tr>
<td>Reimbursement or Payment Due</td>
<td>$ 0.00</td>
<td>Amount back to Cardholder, also populates the one of TOE, maybe split between funding sources.</td>
</tr>
</tbody>
</table>

**Required Documentation:** Supporting documentation must be submitted for Airfare, Conference Registration Fee, Rental Car, and Lodging regardless of amount.

**Traveler Certification:** This notifies the traveler of UCOP policy that any expense of $75 or more that must be supported by an appropriate documentation, and that if a personal auto was used it complies with CA’s auto liability insurance.
Payments Made on Behalf of Traveler: TAR and CTE Card purchases from the above section are added here. Reimbursement or <Payment Due>: is calculated by the following equation:

All Actual Expenses – Travel Advance Request – Corporate Travel & Entertainment Card – Cash Advance = 0, Payment Due, or Reimbursement to Traveler.

This displays the net total of all expenses. A negative value means that a payment is due to the UC Regents on behalf of the traveler, and can be deposited with a Travel Cash Advance Repayment form at the Cashier’s office; attach your deposit slip/receipt to the Post Travel form before submitting. If the value is positive the traveler will receive a reimbursement.

Reimbursement to Traveler:

<table>
<thead>
<tr>
<th>Fund</th>
<th>Organization</th>
<th>Account</th>
<th>Activity</th>
<th>Amount</th>
<th>Description of Expense</th>
<th>Doc. Ref. Number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Manual Reimbursement Journal Entry (Check Box): If a reimbursement is due back to the traveler, the total due from Out-of-Pocket expenses will auto populate into the Amount column in line 1 of the Reimbursement section. If this amount needs to be changed, you can select the check box to reset the field and enter in a custom amount (such as splitting between FOAPALs).

Reimbursement to Traveler: Provide the 5 digit fund number, 6-digit organization code, and 6-digit account code representing the unique funding source for the reimbursement. If no reimbursement is due to the traveler leave section blank.

Transfer of Expense:

<table>
<thead>
<tr>
<th>Fund</th>
<th>Organization</th>
<th>Account</th>
<th>Activity</th>
<th>Amount</th>
<th>Description of Expense</th>
<th>Doc. Ref. Number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Transfer of Expenses: Provide the 5-digit fund number, 6-digit organization code, and 6-digit account code representing the unique funding source for each item, as needed. Additionally, provide the 6-character activity code, if applicable. Enter the amount and notes you would like to assign to each FOAPAL. A Document Reference Number can be added for internal use, if desired. If no Transfer of Expense is required leave blank.

Transfer of Expense Totals:
**Payment Due From Traveler:** Carries over from page 1 of form. If a payment is due from the traveler this field will auto populate in red.

**Transfer of Expense Total:** The sum of all 16 FOAPAL lines from the TOE is calculated here.

**Credit to Default Cardholder FOAPAL:** Enter the default FOAPAL assigned to the Traveler’s CTE Card. If no CTE Card was used put N/A.

**Signatures:**

- **Traveler Signature Required:**
  - Date:

- **Tier 1: Signature Required:**
  - Date:

- **Tier 2: Signature Required:**
  - Date:

- **Senior Officer Auth Signature (if required):**
  - Date:

- **Ex. Other Departmental Expense Authorizer:**
  - Date: [Rev 11/16/2018]

**Authorization:** For additional information on appropriate authorization visit the Authorization and Approvals section of the Travel guide. The Travel & Entertainment Reconciliation Form allows for Electronic Signatures to submit, with the Traveler, Tier 1, and Tier 2 all being required. Senior Officer, or other Department Authorization may be necessary due to budgetary restrictions or policy guidelines. Please note additional signatures required on the Entertainment Reporting Addendum (ERA), as needed. These authorizers may be different than those required for travel authorization.

**Submission:** Once all authorized signatures have been added, the form and required supporting documentation (lodging, airfare, rental car, conference registration, any expense $75 or more, etc.) can be e-mailed to ctecard@ucsc.edu.

**U.S. Bank Statement/Transaction History Download and Review:**

**Logging On:**

- **Welcome to Access Online!**
  - Please enter the information below and login to begin.
  - * = required
  - Organization Short Name:
  - User ID:
  - Password:

- **Login**

- **Forgot your password?**
- **Register Online**

Go to [U.S. Bank Account Login Page](#) to gain access to your account. Log in using the appropriate details, if
you have not established your account use the Register Online option and follow the prompts.

Main Page:

Once logged in, you will be taken to your main account page. From here you can view current statements, update personal information, print previous statements, etc.

Transaction History Report:

To fill out your Travel & Entertainment Reconciliation Form (TERF), you will need to download your current transaction history report if the statement hasn’t closed, or a current statement if the transactions have posted to the account. Select Transaction Management then View Previous Cycle to view either of these.

Select Billing Cycle:
Select the billing cycle that the expenses occurred upon for the TERF.

**Downloading Statement:**

Once the appropriate billing has been selected, all charges made during that period will be visible. Selecting Print Account Activity will open an option to download the statement (some variation in step due to different internet browser preferences).
Account Statements:

Selecting Account Information from the left column of your main page will also open a page to view all previous card statements.

Cardholder Account Statement:

Selecting the Cardholder Account Statement will open all previous statements, which are then directly downloaded when one is selected.

Reconciling Statement:
Once downloaded, review the statement for accuracy. If all charges can be verified, then proceed to enter the appropriate expenses into both the CTE Card Expenses column and the All Expenses Section of the TERF.

**Tip:** The CTE Card Expenses column will match exactly the charges pulled from this statement or transaction history. The All Expenses Section may differ if a TAR, Cash Advance, or Out-of-Pocket expense was also incurred.
Preparing Receipts

Approach A
- Highlight and annotate receipts on the spot.
- Take a picture or use an app (currently under development) to take a picture.
- Create a folder to store pictures.
- Once able, download and join photos in a PDF (by trip, category, date).
- Upload to your folder, save as "Receipts Traveler’s Name Date" (month of the statement/ending month; EX: Receipts John Doe 01.2019).

Approach B
- Keep paper receipts.
- Tape to paper as done previously, with appropriate labels.
- Highlight and annotate the paper or the receipts.
- Scan piece of paper with the receipt attached.

Preparing Expenses
- Go to US Bank (https://www.access.usbank.com).
- Organization Short Name “uofca”.
- Enter name and password.
- Select “Reporting” on the upper left side.
- Select “Transaction Summary”.
- Enter Statement first and last date (for example XX/23/18 to XX/22/18).
- Scroll down to “Report Output”.
- Select “Excel”.
- Press button for “Run Report” and a small window will open with an Excel Spreadsheet.
- Open Excel Spreadsheet.

Preparing Google Share Template
- Go to “Template US Bank Download” File > “Make a Copy”.
- Rename copy “Spreadsheet Traveler’s Name Statement month.year (EX: Spreadsheet John Doe 01.2019).

Moving Expenses from US Bank to Template
- Open US Bank Excel Sheet.
- Highlight data in columns “H” (Merchant Name) through “K” (Transaction Date) (note: careful to just highlight the data and not the header row).
- Edit > Copy.
- Go to “Template US Bank Download” and place cursor in upper left corner cell under header of Column A (“Merchant Name”), Edit > Paste Special > Paste Values Only.

Categorizing Expenses in Template
- Go through expenses line by line.
- Select Trip A, B, C, D.
- Select FAST Category.
- Select Payment method.
- Indicate that you have the receipt.
- Explain any details Tier 1 or Tier 2 need to know about this expense.
Adding Cash and/or Personal Card Payments
- For expenses not on CTE card, user will need to create a new row.
- Highlight Row > Right Click > Insert Row.
- Add Merchant Name, Transaction Amount, Transaction Date (use same date format as other dates).
- Follow same steps as above for Trip, FAST Category, Payment, etc.

Separating Expenses in Hotel Folio
- If there a hotel folio contains multiple FAST Categories, then create a new row for each FAST Category, such as Parking and Hotel, follow instructions above for “Adding Cash and/or Personal Card Payments”.

Mileage
- For Mileage, user will need to create a new row (Highlight Row > Right Click > Insert Row).
- Add Merchant Name (Personal Car), Transaction Amount (put in the miles here - not the dollar amounts), Transaction Date (use same date format as other dates), Explain (Start and End locations and XX Miles).
- Create a new row for each day of personal mileage.
- When ready to submit expenses please add together all miles from Transaction Amount column (by trip) and enter total number of miles into PDF, which will do calculations for you.

Filling out the CTE form
- Using filters in Google Sheets/ Excel, fill out the CTE Trip Details.
- Add the CTE Card (not out of pocket) expenses to the top right box as appropriate.
- Add all expenses that you paid for and put that in the proper cell toward the bottom of the first page.
- Check the FOAPALS.
- Save CTE Form as “CTE Traveler’s Name Date” (month of the statement/ ending month; EX: CTE John Doe 01.2019).

Upload to the Drive
- Three documents will be upload to the drive: CTE PDF, Excel Sheet, TARS, Receipts PDF, CTE Statement.
- Order of Receipts PDF is:
  - By Trip.
  - By Category from top row to bottom row of the CTE Reconciliation Form.
  - By Date of transaction.
- Put them in the Ready for Tier 1 folder.
- Order follows the CTE Reconciliation Form.
Business Contracts Processing of CTE Card’s Purchasing Agreements Requiring UC Signatures

- Requestor is responsible to facilitate all payments with finance.
- BC processing starts once the requestor forwards the Agreement via email to businesscontracts@ucsc.edu.
- Required Information:
  - Requestors full name.
  - Requestors full contact info.
  - Requestor’s department info.
  - Supplier’s full legal name and address (example: HP Inc., not Hewlett-Packard or HP or H.P., etc.).
  - Supplier representative’s name and contact info.
  - Summary on product information that is to be purchased.
  - If applicable - summary of all pertinent information on the background of why the product is being purchased.
  - Any questions about the supplier’s terms and conditions.
  - Any modification requests to the supplier’s terms and conditions, and why the change is being requested.
- BC will contact the requestor directly with any questions and/or instructions.
- Requestor will be responsible for sending the document to the supplier for their signature and forward a soft copy back to BC.
- BC will place a fully executed copy in the associated Gdrive folder.
  - **Important**: Gdrive folder should NOT be used as the official system of record. This responsibility falls on the department to keep the records of purchase outside of CruzBuy.
    - Because this has been executed outside of CruzBuy, the originating department/purchaser is the official office of record for this contract for legacy and audit purposes adhere to the UC document retention policy.
    - [https://rim.ucsc.edu/retention/UCRS.html](https://rim.ucsc.edu/retention/UCRS.html).

**Note**: only Procurement Services has authority to sign contracts on behalf of the University.